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HƯ NG D N S  D NG MONTANA 680Ớ Ẫ Ử Ụ

I. THÔNG S  K  THU T:Ố Ỷ Ậ

- Kích th t máyướ : 7.48 x 14.42 x 3.64 cm
- Kích th t màn hìnhướ : 5.06 x 8.93 cm (4.0”)
- Đ  phân gi i màn hìnhộ ả : 272 x 480 pixels
- Lo i màn hìnhạ : C m ng, tinh th  l ng 65 ngàn màu. ả ứ ể ỏ
- Tr ng l ngọ ượ : 289 gram (k  c  pin Lithium-ion)ể ả
- Ngu n đi n s  d ngồ ệ ử ụ : Pin s c Lithium-ion (kèm theo máy) ho c 3 pin AAạ ặ
- Th i gian s  d ng pinờ ử ụ : kho ng 16 gi  (pin Lithium-ion) ho c 22 gi  (v i pin AA)ả ờ ặ ờ ớ
- Ch ng th mố ấ : đ t tiêu chu n IPX7ạ ẩ
- H  b n đệ ả ồ  : WGS 84, VN 2000, … và nhi u h  b n đ  khácề ệ ả ồ
- H  t a đệ ọ ộ  : UTM, Lat/Long, Maiden head, MGRS,…
- Đ  nh y máy thu ộ ạ  : m nh và c c nhanh, sai s  t  3-10 métạ ự ố ừ
- Dãy nhi t đ  ho t đ ngệ ộ ạ ộ  : t  -15 đ  C đ n 70 đ  Cừ ộ ế ộ
- Giao di n v i máy tínhệ ớ  : USB t c đ  cao và t ng thích v i chu n NMEA 0183ố ộ ươ ớ ẩ
- Cài đ t s n b n đ  hành chính các t nh/thành trong c  n c.ặ ẳ ả ồ ỉ ả ướ
- Dung l ng b  nh  trong:  4.0 GBượ ộ ớ
- H  tr  khe c m th  nh  ngoài, lo i th  Micro SD (không kèm theo máy)ổ ợ ắ ẻ ớ ạ ẻ
- Có kh  năng t i b n đ  vào máy, t ng thích v i ch c năng Custom Mapả ả ả ồ ươ ớ ứ
- B  nh  đi m (waypoint): 4000 đi mộ ớ ể ể
- Hành trình: thi t l p đ c 200 hành trình, m i hành trình có th   đi qua 200 đi mế ậ ượ ỗ ể ể
- B  nh  l u v t: 10.000 đi m, có th  l u đ c 200 Saved Trackộ ớ ư ế ể ể ư ượ
- Ch c năng Routing: d n đ ng theo tu n t  n u đã cài đ t b n đ  giao thông ứ ẫ ườ ầ ự ế ặ ả ồ
- D n đ ng b ng hình nh (photo navigation)ẫ ườ ằ ả
- La bàn đi n t  và khí áp k  đo cao đ  bên trong máyệ ử ế ộ
- Tích h p máy nh k  thu t s  8.0 megapixel, t  đ ng g n to  đ  vào b c nhợ ả ỷ ậ ố ự ộ ắ ạ ộ ứ ả
- Chia s  d  li u v i các GPS t ng thích khác b ng wirelessẽ ữ ệ ớ ươ ằ
- L ch v  tinh (tìm th i gian đo t t nh t)ị ệ ờ ố ấ
- Thông tin m t trăng, m t tr i và l ch th y tri uặ ặ ờ ị ủ ề
- Tính toán chu vi, di n tích ngay trên máyệ
- Ch c năng c nh báo vào vùng nguy hi mứ ả ể
- Ch c năng trình duy t nh k  thu t sứ ệ ả ỷ ậ ố

II. HÌNH NH BÊN NGOÀI: Ả Hình m t tr c và m t sau:ặ ướ ặ  
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1 Th u kính máy nhấ ả
2 Nút ngu nồ
3 Khe c m th  nh  (bên d i h p pin)ắ ẻ ớ ướ ộ
4 N i l p đ  ngu n g n trên ôtôơ ắ ế ồ ắ
5 Jack c m headphoneắ
6 C ng USBổ
7 Khóa m  h p pinở ộ
8 C ng anten ngoàiổ

III. M , T T MÁY & CÁC CH  Đ  MÀN HÌNH:Ở Ắ Ế Ộ

1/ Nh n và gi  phím ấ ữ  kho ng 3 giây đ  t t ho c m  máy.ả ể ắ ặ ở
2/ Ch nh đ  sáng c a màn hìnhỉ ộ ủ : Nh n nh  phím ấ ẹ  , sau đó di chuy n thanh tr tể ượ
trên màn hình đ  đi u ch nh đ  sáng cho thích h p.ể ề ỉ ộ ợ
3/ Khoá màn hình: do là màn hình c m ng và đ  tránh nh ng kích ho t ngoài ý mu n,ả ứ ể ữ ạ ố
ta có th  khoá màn hình l i:ể ạ

- Nh n ấ

- Ch n ọ

2

mailto:maydodachp@gmail.com


 Công ty TNHH máy đo đạc Hải Phòng /Đc: 60 Hùng Vương – Hồng Bàng – Hải Phòng 
                Website: maydodachaiphong.com/ Email: maydodachp@gmail.com
                Hotline: 0965 652 199/ 0316292 468    

Đ  m  khoá màn hình, ta cũng làm t ng t  nh  trênể ở ươ ự ư
IV. CÁCH S  D NG CÁC PHÍM OTRÊN MÀN HÌNH C M NG:Ử Ụ Ả Ả Ứ

- Ch n ọ  đ  m  t t c  các ng d ng trên màn hình menu chínhể ở ấ ả ứ ụ

- Ch n ọ  đ  đóng trang màn hình hi n t i và tr  v  trang màn hình tr c đó.ể ệ ạ ở ề ướ
- Ch n ọ   đ  tr  v  trang màn hình tr c đó.ể ở ề ướ
- Ch n ọ  đ  l u l i nh ng thay đ i và đóng trang màn hình l i.ể ư ạ ữ ổ ạ
- Ch n ọ  và   đ  di chuy n màn hình lên hay xu ng.ể ể ố
- Ch n ọ  đ  m  m t menu phể ở ộ ụ

- Ch n ọ  đ  tìm ki m.ể ế

V. MÀN HÌNH MENU CHÍNH:

T t c  các tính năng c a máy đ u n m trên màn hình Menu chính. Dùng phím ấ ả ủ ề ằ   ho cặ
  đ  chuy n đ i gi a các trang màn hình v i nhau. Trên m i ch c năng, ta có th  nể ể ổ ữ ớ ỗ ứ ể ấ

 đ  m  Menu ph  cho chính ch c năng đó. Các trang màn hình Menu chính g m cóể ở ụ ứ ồ
nh  hình bên d i:ư ướ
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CÀI Đ TẶ

I. CÀI Đ T CHO H  TH NG:Ặ Ệ Ố

T  màn hình Menu chính, ch n ừ ọ Setup > System. B n s  có các l a ch n sau:ạ ẽ ự ọ
- Satellite: nên ch n ọ GPS + GLONASS
- Text language: ch n ọ English.
- Voice Language:  ch n ọ American English-Jill

II. CÀI Đ T CÁC Đ N V  ĐO L NG:Ặ Ơ Ị ƯỜ

    T  màn hình Menu chính, ch n ừ ọ Setup > Units, ta có hình nh  bên d i. Sau đó, có thư ướ ể
cài đ t các đ n v  đo l ng theo ý mu n c a ng i s  d ng.ặ ơ ị ườ ố ủ ườ ử ụ

III. CÀI Đ T TH I GIAN: Ặ Ờ T  màn hình Menu chính, ch n ừ ọ Setup > Time :

-  Time Format: ch n ch  đ  12-hours ho c 24-hoursọ ế ộ ặ
-  Time Zone: ch n ọ Automatic, máy s  t  đ ng ch n múi gi  cho b nẽ ự ộ ọ ờ ạ
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IV. CÀI Đ T H  T A Đ  & H  B N ĐẶ Ệ Ọ Ộ Ệ Ả Ồ: T  màn hình Menu chính, ch n ừ ọ Setup >
Position Format :  

    - Ch n ọ hddd’mm.mmm’ : n u b n mu n xem t a đ  d i d ng đ , phút, giâyế ạ ố ọ ộ ướ ạ ộ
    - Ch n ọ UTM / UPS : n u b n mu n xem t a đ  d i d ng mét.ế ạ ố ọ ộ ướ ạ

Map Datum: ch n ọ WGS 84

* Ngoài ra, n u b n mu n cài đ t h  t a đ  VN 2000, ế ạ ố ặ ệ ọ ộ thao tác nh  sau:ư
Ch n ọ Setup > Position Format > Map Datum > User. Ta có màn hình:

                                            

Sau đó nh p các giá tr  c a DX, DY, DZ vào:ậ ị ủ

DX = - 00193, DY = - 00039, DZ = - 00111

Nh p xong, ch n ậ ọ   đ  l u l i các giá tr  trên, nh n  ể ư ạ ị ấ  đ  thoát kh i màn hình này.ể ỏ

Sau đó ch n l i  ọ ạ Position Format > Position Format > User Grid > UTM và nh p cácậ
giá tr  d i đây vàoị ướ  :
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Sai số
T a đ  n i đ t máyọ ộ ơ ặ

S  th  t  c a v  tinhố ứ ự ủ ệ

Cao độ

Đ  m nh, y u c a tín hi u v  tinhộ ạ ế ủ ệ ệ
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- False Easting : Đ i giá tr  thành 500000.0mổ ị
- False Northing: Đ i giá tr  thành 0.0mổ ị
- Scale: gi  nguyên giá tr  ho c đ i thành ữ ị ặ ổ 0.9999000, tùy theo l i chi u s  d ng.ướ ế ử ụ
- Longitude Origin: nh p kinh tuy n tr c c a đ a ph ng vào.ậ ế ụ ủ ị ươ

Nh p xong m i giá tr  ch n ậ ỗ ị ọ  đ  l u l i. Sau đó ch n ể ư ạ ọ   đ  thoát ra và ti p t cể ế ụ
nh p các giá tr  ti p theo.ậ ị ế

 L u ý: Nh  chuy n ch  ư ớ ể ữ W thành E  tr c giá tr  c a kinh tuy n tr cướ ị ủ ế ụ
(xem danh sách kinh tuy n g c c a t t c  các t nh thành  ph n cu i)ế ố ủ ấ ả ỉ ở ầ ố

CÁC THAO TÁC TH NG S  D NGƯỜ Ử Ụ

I. ĐO VÀ L U L I M T T A Đ  ĐI M (Waypoint): Ư Ạ Ộ Ọ Ộ Ể

Sau khi m  máy, đ i vài giây cho máy thu đ c tín hi u v  tinh. Ch n ở ợ ượ ệ ệ ọ Sattelite để
ki m tra, khi nào máy thu đ c tín hi u v  tinh nh  màn hình bên d i - khi đó máy đãể ượ ệ ệ ư ướ
s n sàng ho t đ ng. Máy có th  đo và l u tr  đ c 4.000 t a đ  đi m v i tên và bi uẳ ạ ộ ể ư ữ ượ ọ ộ ể ớ ể
t ng khác nhau.ượ
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1/ Đo và l u l i v  trí đang đ t máy:ư ạ ị ặ

- M  máy và ch  thu tín hi u t  v  tinh, đ t máy t i v  trí c n đo.ở ờ ệ ừ ệ ặ ạ ị ầ
- Nh n vào l nh ấ ệ Mark Waypoint
- Ch n ọ Save đ  l u thông tin vào máy. Máy s  t  đ ng l u l i tên t a đ  đi m theoể ư ẽ ự ộ ư ạ ọ ộ ể

d ng s  th  t  1, 2, 3 …. N u thích, b n có th  ch n l nhạ ố ứ ự ế ạ ể ọ ệ  Edit đ  đ t l i tên vàể ặ ạ
bi u t ng cho t ng v  trí.ể ượ ừ ị

              

2/ L u l i 1 t a đ  b t kỳ:ư ạ ọ ộ ấ
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- Vi c đ u tiên là ghi l i t a đ  c n l u ra gi y.ệ ầ ạ ọ ộ ầ ư ấ
- Ch n l nh ọ ệ Mark Waypoint
- Ch n l nh ọ ệ Edit
- Ch n ọ Location, máy s  hi n ra 1 b ng ch  s , s  d ng b ng ch  s  này và cácẽ ệ ả ữ ố ử ụ ả ữ ố

mũi tên đ  nh p t a đ  m i vào. ể ậ ọ ộ ớ

- Nh n ấ  đ  hòan t t vi c nh p d  li uể ấ ệ ậ ữ ệ
- Ch n ọ Save đ  l u l iể ư ạ

3/ Đo 1 t a đ  gi  đ nh:ọ ộ ả ị

Ch c năng này dùng đ  đo t a đ  b t kỳ m t đi m nào mà ta th y trên màn hình b n đ ,ứ ể ọ ộ ấ ộ ể ấ ả ồ
ho c ta nhìn th y ngòai th c đ a nh ng không th  đ n ngay v  trí đó đ c (VD: n mặ ấ ự ị ư ể ế ị ượ ằ
gi a ao, h  ho c đ a hình hi m tr ,…)ữ ồ ặ ị ể ở

- Ch n ọ Map đ  đ a v  màn hình b n đ .ể ư ề ả ồ
- Ch m vào v  trí trên b n đ  mà ta c n l u l i (c n phóng to b n đ  càng l n càngạ ị ả ồ ầ ư ạ ầ ả ồ ớ

t t, nh  v y v  trí c n l u s  chính xác h n)ố ư ậ ị ầ ư ẽ ơ
- Trên đ nh màn hình s  hi n ra m t dòng thông tin. Ch m ti p vào dòng thông tinỉ ẽ ệ ộ ạ ế

đó, trên đ nh màn hình s  hi n ra t a đ , cao đ  và kh ang cách đ n đi m mà taỉ ẽ ệ ọ ộ ộ ỏ ế ể
c n l u.ầ ư

- Ch m vào hình ạ  đ  l u l i t a đ  đi m đó. Nh n ể ư ạ ọ ộ ể ấ OK đ  hòan t t công vi c.ể ấ ệ

                
    

4/ Hi u ch nh Waypoint:ệ ỉ
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Sau khi đã l u Waypoint vào b  nh , b n có th  hi u ch nh đ  thay đ i tên, bi uư ộ ớ ạ ể ệ ỉ ể ổ ể
t ng, t a đ , cao đ , hình nh… c a m t Waypoint b t kỳ.ượ ọ ộ ộ ả ủ ộ ấ

- Vào Waypoint Manager
- Ch n 1 Waypoint mà ta c n hi u ch nh.ọ ầ ệ ỉ
- Ch n 1 thu c tính c n hi u ch nh nh  tên,bi u t ngọ ộ ầ ệ ỉ ư ể ượ , t a đ , ọ ộ Elevation: cao đ ,..ộ
- Ch n ch , con s , bi u t ng c n thi t cho s  thay đ iọ ữ ố ể ượ ầ ế ự ổ

- Nh p vào hình ấ  đ  hòan t t vi c hi u ch nhể ấ ệ ệ ỉ

- Nh p vào hình  ấ  đ  thóat kh i ch c năng này.ể ỏ ứ

5/ Xóa Waypoint:

a/ Xóa 1 Waypoint: 
- Vào Waypoint Manager
- Ch n 1 Waypoint mà b n c n xóaọ ạ ầ
- Ch n bi u t ng ọ ể ượ
- Ch n ọ Delete. Máy s  hi n ra 1 câu h i, ti p t c ch nẽ ệ ỏ ế ụ ọ  Delete : đi m đã đ c xoáể ượ

b/ Xóa t t c  Waypoint:ấ ả
H t s c c n th n khi s  d ng ch c năng này, m t khi d  li u đã b  xoá thì không thế ứ ẩ ậ ử ụ ứ ộ ữ ệ ị ể
khôi ph c l i đ c. thao tác nh  sau:ụ ạ ượ ư

Ch n ọ Setup > Reset > Delete All Waypoints > Delete

Khi b n xóa b  1 Waypoint nào đó, thì hình nh g n li n v i Waypoint đó v n ch aạ ỏ ả ắ ề ớ ẫ ư
đ c xóa. Mu n xóa hình nh, b n ph i vào ượ ố ả ạ ả Photo Viewer.

II. S  D NG MÁY CH P NH (Camera):Ử Ụ Ụ Ả

Montana 650 có tích h p 1 Camera 5.0 Megapixel. Khi b n ch p nh, hình nh sợ ạ ụ ả ả ẽ
đ c l u l i cùng v i t a đ  c a b c nh. B n có th  dùng ch c năng d n đ ng đượ ư ạ ớ ọ ộ ủ ứ ả ạ ể ứ ẫ ườ ể
tìm v  trí b c nh gi ng nh  tìm m t Waypoint.ị ứ ả ố ư ộ

1/ Cài đ t cho máy nh: ặ ả

    Ch nọ  Setup > Camera, ta có hình nh  bên d i         ư ướ
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2/ Ch p nh:ụ ả

- Ch n ọ Camera
- N u c n thi t, có th  ch m vào bi u t ng ế ầ ế ể ạ ể ượ  đ  ch n ch  đ   ánh sáng choể ọ ế ộ

thích h p.ợ
- Ch m vào d u ạ ấ + ho c ặ – , đ  ch n ch  đ  ch p xa hay g n ể ọ ế ộ ụ ầ
- Ch m nh  vào bi u bi u t ng ạ ẹ ể ể ượ  đ  ch p b c nhể ụ ứ ả

- Ch m vào ạ  đ  thóat kh i Cameraể ỏ

3/ Xem l i b c nh đã ch p:ạ ứ ả ụ

- Ch n ọ Photo Viewer
- Ch n b c nh c n xemọ ứ ả ầ
- Ch m vào bi u t ng ạ ể ượ , ta có các l a ch n sau:ự ọ

+ View Map: xem v  trí b c nh trên b n đị ứ ả ả ồ
+ View Information: xem thông tin v  b c nh nh  to  đ , ngày ch p,…ề ứ ả ư ạ ộ ụ
+ Delete Photo: xóa nhả
+ Set As Wallpaper: ch n nh làm hình n nọ ả ề
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III. S  D NG LA BÀN ĐI N T :Ử Ụ Ệ Ử

Màn hình la bàn th ng dùng đ  d n đ ng. Khi b n c n di chuy n đ n 1 đi mườ ể ẫ ườ ạ ầ ể ế ể
nào đó, ph n mũi nh n c a ▲ luôn luôn ch  v  đi m mà b n c n đi đ n, b t ch pầ ọ ủ ỉ ề ể ạ ầ ế ấ ấ
h ng mà b n đang di chuy n. N u mũi tên ch  v  đ nh c a la bàn, khi đó b n đã điướ ạ ể ế ỉ ề ỉ ủ ạ
đúng h ng.ướ

 màn hình này còn cung c p cho b n các thông s  nhỞ ấ ạ ố ư : t c đ  hi n t i, kho ngố ộ ệ ạ ả
cách đ n đi m đ n và th i gian d  ki n k t thúc hành trình.                                     ế ể ế ờ ự ế ế

1/ Hi u ch nh l i la bàn:ệ ỉ ạ

Trong quá trình s  d ng n u th y la bàn trong máy l ch so v i th c t , ta nên hi uử ụ ế ấ ệ ớ ự ế ệ
ch nh l i. M t khác, nên hi u ch nh l i la bàn đi n t  sau khi b n đã di chuy n 1 kho ngỉ ạ ặ ệ ỉ ạ ệ ử ạ ể ả
cách xa ho c có  s  thay đ i nhi u v  nhi t đ  (t  11 đ  C). Vi c này ta nên làm  ngoàiặ ự ổ ề ề ệ ộ ừ ộ ệ ở
tr i và không nên đ ng g n nh ng v t có phát ra t  tr ng (xe ô tô, đ ng dây đi n,...).ờ ứ ầ ữ ậ ừ ườ ườ ệ
Thao tác nh  sau:ư
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- Vào  Setup > Heading > Calibrate Compass,  nh nấ
Start. Sau đó làm theo nh  minh h a trên màn hình. ư ọ

                                                        
Ho c: ặ

- Ch n ọ Compass, la bàn s  xu t hi n. Sau đó, c m vàẽ ấ ệ ầ
gi  ngay gi a la bàn, nh n  ữ ữ ấ Start và làm theo minh
h a trên màn hình.ọ

N u xu t hi n dòng ch  ế ấ ệ ữ “Calibration Failed”  - quá trình
hi u ch nh ch a đ t.  B n ph i  nh n  ệ ỉ ư ạ ạ ả ấ Ok và  l p  l i  quáặ ạ
trình.

2/ Hi u ch nh Sensor đo cao đ :ệ ỉ ộ

Đ  máy có th  đo cao đ  chính xác h n (đ  cao so v i m t n c bi n), b n nên hi uể ể ộ ơ ộ ớ ặ ướ ể ạ ệ
ch nh l i thi t b . Ta ph i đi đ n n i mà ta bi t chính cao đ  ho c áp su t đ  hi u ch nh.ỉ ạ ế ị ả ế ơ ế ộ ặ ấ ể ệ ỉ
Máy s  căn c  vào c t m c chu n này đ  đo chính xác h n các đi m v  sau.ẽ ứ ộ ố ẩ ể ơ ể ề

- Vào Setup > Altimeter > Calibrate Altimeter
- Nh n ấ Yes n u b n bi t cao đ . Nh n ế ạ ế ộ ấ No, sau đó ch n ọ Yes n u b n bi t áp su t.ế ạ ế ấ

- Sau đó nh p giá tr  cao đ  ho c áp su t vào. Nh n ậ ị ộ ặ ấ ấ   đ  hòan t t công vi cể ấ ệ
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*Chú ý: đ n v  đo cao đ  và áp su t ph i t ng ng v i các đ n v  đo l ng mà b n đãơ ị ộ ấ ả ươ ứ ớ ơ ị ườ ạ
ch n  ph n cài đ t.ọ ở ầ ặ

IV. HÀNH TRÌNH (Route)  :

Hành trình là bao g m m t chu i các t a đ  đi m mà nó d n b n đi t  đi m đ uồ ộ ổ ọ ộ ể ẫ ạ ừ ể ầ
tiên đ n đ n đi m cu i cùng, m t hành trình ph i có ít nh t 2 đi m.Thi t b  này có thế ế ể ố ộ ả ấ ể ế ị ể
l u đ c 200 hành trình, m i hành trình có th  đi qua đ c 200 t a đ  đi m. ư ượ ỗ ể ượ ọ ộ ể

1/ Thi t l p m t hành trình: ế ậ ộ

-  B c 1ướ : Vào Route Planner > Create Route > Select First Point :  ch n đi m kh iọ ể ở
hành cho hành trình.
- B c 2ướ : Ch n 1 trong các tùy ch n sau:ọ ọ

         + Use Map: màn hình b n đ  hi n ra, ch m vào b t kỳ đi m nào mà b n mu n.ả ồ ệ ạ ấ ể ạ ố
+ Recent Finds: nh ng đi m đ c l u trong th i gian g n nh tữ ể ượ ư ờ ầ ấ

         + Waypoint: máy s  hi n ra danh sách Waypoint đã l u trong máy, hãy ch n choẽ ệ ư ọ
b n m t Waypoint.ạ ộ
         + Photos: Ch n 1 hình nh.ọ ả
- B c 3 ướ : Ch n ọ Use: máy s  ch n 1 trong các tùy ch n  trên làm đi m kh i hành.ẽ ọ ọ ở ể ở
- B c 4ướ  : Ch n ọ Select Next Point: ch n đi m k  ti p cho hành trình.ọ ể ế ế
- B c 5ướ  : l p l i b c 2 và 3 cho đ n khi b n ch n xong đi m k t thúc hành trình.ặ ạ ướ ế ạ ọ ể ế

- B c 6 ướ : Nh n ấ   đ  thoát ra và l u l i hành trình.ể ư ạ

2/ Xem l i m t hành trình trên b n đ :ạ ộ ả ồ

- Vào Route Planner
- Ch n 1 hành trình mà b n mu n xem. Nh n  ọ ạ ố ấ View Map: hành trình c a b n sủ ạ ẽ

hi n ra trên b n đ .ệ ả ồ

3/ Ch nh s a m t hành trình:ỉ ử ộ

Có th  ch nh s a l i b t c  hành trình nào mà b n đã t o tr c đó.ể ỉ ử ạ ấ ứ ạ ạ ướ
- Vào Route Planner
- Ch n m t hành trình mà b n mu n ch nh s aọ ộ ạ ố ỉ ử
- Ch m vào m t đi m mà b n mu n ch nh s a, s  có các tùy ch n sau:ạ ộ ể ạ ố ỉ ử ẽ ọ

+ Review: xem thông tin c a c a đi m đó: t a đ , cao đ  , kho ng cách đ n.ủ ủ ể ọ ộ ộ ả ế
+ Move Down (or Up) : thay đ i th  t  c a đi m trên hành trình.ổ ứ ự ủ ể
+ Insert: thêm m t đi m m i vào hành trìnhộ ể ớ
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+ Remove: l ai b  1 đi m ra kh i hành trìnhọ ỏ ể ỏ

4/ Hành trình ng cượ :

B n có th  đ o chi u m t hành trình, khi đó đi m kh i đ u s  là đi m k t thúc c aạ ể ả ề ộ ể ở ầ ẽ ể ế ủ
hành trình và th  t  các đi m trong hành trình cũng đ c đ i theo t ng ng. S  d ngứ ự ể ượ ổ ươ ứ ử ụ
ch c năng này khi ta đã đi h t m t hành trình và mu n tr  v  trên con đ ng đã đi tr cứ ế ộ ố ở ề ườ ướ
đó.

- Vào Route Planner
- Ch n hành trình mà b n mu n đ o chi u ọ ạ ố ả ề > ch n Reverse Routeọ

5/ Xóa m t hành trình:ộ

- Vào Route Planner
- Ch n 1 hành trình c n xóa, nh n ọ ầ ấ Delete Route > Delete

V. TRACK (V t, đ ng đi):ế ườ

T t c  các thi t b  GPS c a Garmin s  ghi l i d u v t (Track) trong quá trình diấ ả ế ị ủ ẽ ạ ấ ế
chuy n. B n có th  l u l i nh ng track này đ  s  d ng sau đó. Thi t b  này có th  l uể ạ ể ư ạ ữ ể ử ụ ế ị ể ư
l i đ c 200 Track.ạ ượ

1/ Qu n lý Track Log:ả

- T  Menu chính, ch n ừ ọ Setup > Tracks > Tracks Log
- Ch n ọ Record Method, Distance ho c ặ Record Method, Time ho c ặ Auto
    N u b n ch n ế ạ ọ Distance/Time : Track c a b n s  t  đ ng l u theo kho ng cách/th iủ ạ ẽ ự ộ ư ả ờ
gian ch  đ nh.ỉ ị

2/ Xem Track hi n t i:ệ ạ
    
 Track đang đ c ghi g i là track hi n t i ượ ọ ệ ạ

T  menu chính, ch n ừ ọ Current Track ho c ặ Track Manager > Current Track
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3/ L u l i Track hi n t i:ư ạ ệ ạ

a/ T  Menu chính, ch n ừ ọ Current Track ho cặ Track Manager > Current Track
b/ Ch n 1 trong 2 ki u l u sau:ọ ể ư

- B m vào bi u t ngấ ể ượ   để Save Track : l u l i tòan b  trackư ạ ộ
- B m vàoấ   ch nọ  Save Portion: cho phép b n l u l i m t đ an nào đó c a trackạ ư ạ ộ ọ ủ

4/ Reset Track hi n t i (Current Track)ệ ạ
Vì máy có tính năng t  đ ng ghi l i toàn b  đo n đ ng đã đi qua, trong đó cóự ộ ạ ộ ạ ườ

nh ng đo n đ ng mà ta không c n đ n. Đ c bi t, đ i v i nh ng máy Garmin th  hữ ạ ườ ầ ế ặ ệ ố ớ ữ ế ệ
m i, nó có tính năng t  đ ng n i đi m đ u c a Track này v i đi m cu i c a Track ti pớ ự ộ ố ể ầ ủ ớ ể ố ủ ế
theo (m c dù gi a 2 l n đo ta đã t t máy). Vì v y, đ  tránh tình tr ng các Track này dínhặ ữ ầ ắ ậ ể ạ
chùm v i nhau, tr c khi ti n hành đo ta nên xóa nh ng Track t m th i này đi, vi c xóaớ ướ ế ữ ạ ờ ệ
nh ng Track này không nh h ng gì đ n nh ng Track đã l u tr c đó. Thao tác nhữ ả ưở ế ữ ư ướ ư
sau :

Ch nọ  Track Manager  > Current Track > Clear current Track  > Clear

Ho c: t  Menu chính, ch n ặ ừ ọ Setup > Reset > Clear Current Track > Clear

5/ Xóa 1 Track đã l u trong máy:ư

- T  Menu chính, ch n ừ ọ Track Manager
- Ch n track mà ta c n xóaọ ầ
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- Ch n ọ  > Delete > Delete
CÁC CH C NĂNG CHÍNHỨ

I. CH C NĂNG D N Đ NG:Ứ Ẫ ƯỜ

Thi t b  này có th  d n b n đi đ n b t kỳ t a đ  đi m, hình nh nào đã l u trong máy ế ị ể ẫ ạ ế ấ ọ ộ ể ả ư
ho c đi theo Track, hành trình mà b n đã t o ra.ặ ạ ạ

T  màn hình Menu chính, ch n ừ ọ Where To ? Máy s  li t kê ra các tùy ch n sau:ẽ ệ ọ

- Waypoint: ch n Waypoint mà b n c n đi đ n. Sau đó ch n ọ ạ ầ ế ọ Go
- Photos : ch n m t hình nh mà b n c n đi đ n > ch n ọ ộ ả ạ ầ ế ọ Go
- Track : ch n m t Track mà b n c n đi > ch n ọ ộ ạ ầ ọ Go 
- Route: ch n 1 hành trình mà b n mu n đi > ch n ọ ạ ố ọ Go, máy s  d n b n đ n đi mẽ ẫ ạ ế ể

kh i hành c a hành trình và sau đó đi theo hành trình mà b n đã l p tr c đó.ở ủ ạ ậ ướ
- Geocaches: d n đ ng đ n m t v  trí, đ a danh đã đ c l p s n.ẫ ườ ế ộ ị ị ượ ậ ẵ
- Coordinates: D n đ ng đi đ n 1 đi m mà ta bi t t a đ  c a đi m đó, sau khiẫ ườ ế ể ế ọ ộ ủ ể

ch n ọ Coordinates, ta có màn hình nh  bên d i. Dùng các ch  s  đ  nh p t a đư ướ ữ ố ể ậ ọ ộ

m i vào, xong ch nớ ọ  đ  l u l i. Trên màn hình s  xu t hi n m t đ ng th ngể ư ạ ẽ ấ ệ ộ ườ ẳ
n i t  đi m ta đang đ ng đ n đi m mà ta v a nh p t a đ  vào. ố ừ ể ứ ế ể ừ ậ ọ ộ
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Sau khi ch n m tọ ộ trong  các
tùy ch n trên và ch n l nhọ ọ ệ  Go. Trên màn hình b n đ  s  hi n ra m t đ ng th ng n i tả ồ ẽ ệ ộ ườ ẳ ố ừ
n i ta đang đ ng đ n đi m mà ta c n đi đ n. Nên thoát kh i màn hình b n đ  đ  chuy nơ ứ ế ể ầ ế ỏ ả ồ ể ể
sang màn hình la bàn (ch n ọ Compass) và di chuy n theo h ng ch  c a la bàn. Trên mànể ướ ỉ ủ
hình này, ta cũng có th  th y các thông s  nh  t c đ  đang di chuy n, kh ang cách vàể ấ ố ư ố ộ ể ỏ
th i gian đ n đích.ờ ế

Khi v  đ n đích, máy s  phát ra m t ti ng beep và trên màn hình s  hi n ra dòng chề ế ẽ ộ ế ẽ ệ ữ
Arriving At “tên đi m”.ể
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Đ  d ng  ch c  năng  d n  đ ng:  ch n  ể ừ ứ ẫ ườ ọ Where
To ?, ch n ọ Stop Navigation

II.  CH C  NĂNG  TÍNH  DI N  TÍCH  M TỨ Ệ Ộ
KHU V C:Ự

Tr c khi đo m t khu v c nào đó, ta nênướ ộ ự
dung l nh  ệ Clear Current Track.  Vi c này giúpệ

cho hình dáng các khu v c không dính li n nhau, máy s  cho ta th y v  trí và hình dángự ề ẽ ấ ị
c a t ng khu v c riêng bi t. Vi c xóa Track này không nh h ng gì t i nh ng Track màủ ừ ự ệ ệ ả ưở ớ ữ
b n đã l u tr c đó.Thao tác nh  sau :t  màn hình Menu chính:ạ ư ướ ư ừ

Ch nọ  Track Manager > Current Track > Clear Current Track > Clear
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 Thao tác đo di n tích:ệ

- Vào Area Calculation > Start
- Đi vòng quanh khu v c mà b n mu n đoự ạ ố
- Ch n ọ Calculate khi b n đi đ n đi m cu i cùng (ph i trùng v i đi m xu t phát)ạ ế ể ố ả ớ ể ấ
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Sau khi nấ  Calculate, s  có các màn hình sau:ẽ

- Ch n ọ Save Track đ  l u l i track nàyể ư ạ
- Ch n ọ Change Units đ  đ i các đ n v  đo l ng (hecta, m, km,..)ể ổ ơ ị ườ

Đ  xem di n tích và chu vi c a m t Track đã l u tr c đó:ể ệ ủ ộ ư ướ

- T  màn hình Menu chính, vào ừ Track Manager
- Ch n 1 Track mà b n c n xemọ ạ ầ

     -     Ch n ọ View Map, hình dáng c a Track c n xem s  hi n th  trên b n đ .ủ ầ ẽ ể ị ả ồ
- Ch m vào tên c a Track (trên đ nh c a màn hình): chu vi (chi u dài) và di n tích ạ ủ ỉ ủ ề ệ

c a Track đó s  hi n ra.ủ ẽ ệ
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Xem chu i hình minh ho  d i đây :ổ ạ ướ

                 

                                                

CÁC TÍNH NĂNG KHÁC
                         
Môt s  công c  th ng s  d ng trên màn hình Menu chính:ố ụ ườ ử ụ

1/ Calendar: Hi n th  l ch, đ ng th i cho ta bi t s  Waypoint, Track mà ta đã l u đ cể ị ị ồ ờ ế ố ư ượ
trong m t ngày nào đó.ộ

2/     Sun and Moon: cho bi t th i gian m t tr i, m t trăng m c và l n trong ngày t i v  tríế ờ ặ ờ ặ ọ ặ ạ ị
mà b n đ t máy.                       ạ ặ
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3/     Hunt and Fish: cho bi t l ch v  tinh t t nh t trong ngày t i v  trí đ t máyế ị ệ ố ấ ạ ị ặ
                                 
Mu n xem l ch v  tinh c a ngày khác thì di chuy n v t sáng đ n ngày đó. Khi đó l ch vố ị ệ ủ ể ệ ế ị ệ
tinh cũng thay đ i theo t ng ng.ổ ươ ứ

4/Trip Computer:
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Ch c  năng  này  dùng  đ  đoứ ể
chi u  dài  c a  qu ng  đ ngề ủ ả ườ
th c t  mà b n đã đi (khôngự ế ạ
ph i đ ng chim bay). ả ườ

Ngoài ra nó cũng hi n th  t cể ị ố
đ  b n  đang  di  chuy n,  t cộ ạ ể ố
đ  trung bình, t c đ  t i đa,ộ ố ộ ố
chi u  dài  qu ng  và  nh ngề ả ữ
thông s  khác.ố

                                   
Tr c khi kh i hành, đ  có nh ng thông tin chính xác h n, ta nên đ a t t c  các giá tr  ướ ở ể ữ ơ ư ấ ả ị ở
màn hình này v  = 0. Thao tác nh  sau:ề ư

Ch n ọ Reset > Reset Trip Data > Reset

5/ Proximity
Alarms:

ch c năng này ch  y u dùng đ  c nh báo. Máy s  báo đ ng khi ta đi vào ph m vi c aứ ủ ế ể ả ẽ ộ ạ ủ
m t vùng nào đó do ta cài đ t tr c. Vi d  nh  bãi bom mìn, vùng ô nhi m phóng x ,ộ ặ ướ ụ ư ể ạ
dãy đá ng m,…ầ
T  màn hình menu chính, ch n ừ ọ Proximity Alarms > Create Alarm
Trên màn hình s  xu t hi n các tùy ch n đ  làm tâm cho vùng c n c nh báo. Thôngẽ ấ ệ ọ ể ầ ả
th ng ta dùng b n đ  ườ ả ồ (Use Map) ho c t a đ  ặ ọ ộ (Waypoints) .
Sau khi ch n xong đi m c n c nh báo t  danh sách các waypoint hay trên b n đ , ti pọ ể ầ ả ừ ả ồ ế
t c ch n ụ ọ Use, s  xu t hi n màn hình nh  d i đây:ẽ ấ ệ ư ướ     
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Chú ý: đ n v  tính m c đ nh  đây là ơ ị ặ ị ở mile (1 mile = 1609 mét) nh ng tr c khi cài đ t ư ướ ặ
c nh báo, ta có th  đ i ra đ n v  métả ể ổ ơ ị

Có th  hi u đi m mà b n mu n c nh báo là tâm c a 1 vòng tròn, kho ng cách mà b nể ể ể ạ ố ả ủ ả ạ
mu n cài đ t là bán kính c a vòng tròn. Khi ta đi vào  ph m vi c a vòng tròn đó, máy số ặ ủ ạ ủ ẽ
báo đ ng.ộ

6/ Share Wireless (Chia s  d  li u)ẽ ữ ệ  

Montana 650 có kh  năng chia s  d  li u (Waypoint, Track, Route,…) b ng công nghả ẽ ữ ệ ằ ệ
Bluetooh v i nh ng thi t b  Garmin t ng thích khác.ớ ữ ế ị ươ

- Đ t 2 thi t b  g n nhau trong ph m vi 3 métặ ế ị ầ ạ
- Trên màn hình Menu chính c a 2 thi t b , ch n ủ ế ị ọ Share Wireless
- Trên thi t b  nh n d  li u, ch n ế ị ậ ữ ệ ọ Receive. 
- Trên thi t b  g i d  li u, ch n ế ị ở ữ ệ ọ Send
- Trên thi t b  g i, ch n lo i d  li u mà ta c n g i > ch n ế ị ở ọ ạ ữ ệ ầ ở ọ Send m t l n n aộ ầ ữ
- Khi trên màn hình c a máy g i và nh n hi n th  s  chuy n d  li u đã hòan t t > ủ ở ậ ể ị ự ể ữ ệ ấ OK
trên c  2 thi t b .ả ế ị

TRUY N D  LI U VÀO MÁY TÍNHỀ Ữ Ệ

 
Đ  truy n d  li u t  máy Garmin GPS vào máy tính đ i v i dòng máy Montana, Oregon,ể ề ữ ệ ừ ố ớ
78 seri,  62 seri,  eTrex 10-20-30 ….ta có th  s  d ng 2 ph n m m là  ể ử ụ ầ ề Mapsource  và
Basecamp.
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Ph n m m Basecamp có u đi m là t  đ ng trút t t c  d  li u t  máy GPS vào máy tínhầ ề ư ể ự ộ ấ ả ữ ệ ừ
khi có k t n i gi a máy GPS và máy tính; và cho phép xu t d  li u  đ nh d ng ế ố ữ ấ ữ ệ ở ị ạ “.*csv”
là đ nh d ng có th  m  trong excel đ  x  lý sau đó m  đ c trong Mapinfo.ị ạ ể ở ể ử ở ượ
Ph n m m Mapsource có u đi m là cho phép xu t d  li u  đ nh dang ầ ề ư ể ấ ữ ệ ở ị “.*dxf” là đ nhị
d ng có th  m  tr c ti p trong AutoCad và xu t d  li u b ng import vào trong Mapinfo.ạ ể ở ự ế ấ ữ ệ ằ
Ngoài ra, c  2 ph n m m đ u có u đi m cho phép xu t d  li u  d ng  ả ầ ề ề ư ể ấ ữ ệ ở ạ “*.txt” mở
đ c  notepad; excel.ượ ở

Ghi  Chú   : Yêu c u c u hình máy tính ph i :ầ ấ ả

- Windows XP Service Pack 3 ho c m i h nặ ớ ơ  là b t bu c.ắ ộ
-  2 GB b  nh  h  th ngộ ớ ệ ố  đ c khuy n cáo.ượ ế
- Mu n xem ch  đ  3D, ph i có ố ế ộ ả  card màn hình h  trỗ ợ OpenGL phiên b nả  1.3 ho cặ

m i h nớ ơ  là c n thi tầ ế .

Cài đ t ph n m m MapSource và cài đ t ph n m m Garmin BaseCampặ ầ ề ặ ầ ề

- G n cáp truy n USB vào máy GPS và máy tính.ắ ề
- Tim đ n th  m c ế ư ụ Garmin, kích đúp vào và ch n ọ File cài đ t.ặ  

Trong File cài đ t có hai ph n m m ặ ầ ề Mapsource và Basecamp.
Coppy File cài đ t này ra máy tính và b t đ u kích đúp vào nó đ  cài.ặ ắ ầ ể
Theo hình sau:
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Các b c ti n hành truy n d  li u dùng ph n m m Basecampướ ế ề ữ ệ ầ ề

B c 1ướ : M  máy GPS, g n cáp truy n USB vào máy GPS và máy tính.ở ắ ề

B c 2ướ : Kh i đ ng ph n m m Basecamp.ở ộ ầ ề

D  li u t  máy GPS s  t  đ ng truy n vào Basecamp. D  li u truy n vào s   trongữ ệ ừ ẽ ự ộ ề ữ ệ ề ẽ ở
Internal Storange. Ta đ c nh  sau: ượ ư

B c 3ướ : Cài đ t các thông s  ph n m m Basecamp:ặ ố ầ ề

Trên Garmin Basecamp, ch n ọ Edit, ch n ọ Options.., kích ch n ọ Measurement.
+ Cài đ t đ n v  đo  ô ặ ơ ị ở Measurement System (ch n ọ metric).
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+ Cài đ t Position đ  ch n cách th  hi n t a đ  các đi m theo kinh đ , vĩ đ  (ch nặ ể ọ ể ệ ọ ộ ể ộ ộ ọ
Lat/Lon hddd0 mm.mmm’ ), ho c t a đ  ặ ọ ộ UTM (met), ho c ặ VN2000.

B c 4ướ : L u d  li u trên máy tính:ư ữ ệ

T  màn hình Basecamp, ch n ừ ọ File, ch n ọ Export, ch n ọ Export Internal Storage n uế
mu n l u toàn b  d  li u v a m i chuy n t  máy GPS vào ho c ố ư ộ ữ ệ ừ ớ ể ừ ặ Export Selection
đ  l u d  li u đ c ch n…đ c  màn hình:ể ư ữ ệ ượ ọ ượ

- Đ t tên file c n l u (ặ ầ ư File name) và ch n ki u d  li u l u (ọ ể ữ ệ ư Save as type):

+  Garmin  GPS  Database  Files  (*.gdb):  d  li u  ch y  đ c  trên  Basecamp,ữ ệ ạ ượ
Mapsource.
+ GPS exchange Format (*.gpx): d  li u ch y đ c trên Basecamp, Mapsource.ữ ệ ạ ượ
+ Comma- delimited text (*.csv) : d  li u ch y đ c trên Excel.ữ ệ ạ ượ
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+ Tab delimited (*.txt) : d  li u ch y đ c trên Notepad, Excel.ữ ệ ạ ượ

Các b c ti n hành truy n d  li u dùng ph n m m Mapsourceướ ế ề ữ ệ ầ ề

B c 1ướ : M  máy GPS, g n cáp truy n USB vào máy GPS và máy tính.ở ắ ề

B c 2ướ : Kh i đ ng ph n m m Mapsource, ta có màn hình: ở ộ ầ ề

Có 3 cách xu t d  li u t  GPS vào Mapsource:ấ ữ ệ ừ

 Cách 1: Vào Transfer\Receive From Device…

 Cách 2: Ch n vào bi u t ng máy GPS trên Toolbar (ch  khoanh tròn đ )ọ ể ượ ỗ ỏ
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Xu t hi n c a s  sau:ấ ệ ử ổ

N u ô ế Device ch a sáng lên và ch a hi n th  ư ư ể ị Model c a thi t b  GPS nghĩa là máy tínhủ ế ị
và máy GPS ch a k t n i, ta ph i ki m tra l i dây cáp k t n i.ư ế ố ả ể ạ ế ố
Sau khi máy tính hi u đ c máy GPS, ch n nh ng ô d  li u mu n truy n t  máy GPSể ượ ọ ữ ữ ệ ố ề ừ
vào máy tính: Maps (b n đ ); ả ồ Routes (hành trình); Waypoint (đi m t a đ ); ể ọ ộ Tracks (l uư
v t đ ng đi) đ  chuy n nh ng d  li u này vào máy tính.ế ườ ể ể ữ ữ ệ
Ch n ọ Receive, đ c thông báo:ượ

Ch n ọ OK k t thúc vi c truy n d  li u.ế ệ ề ữ ệ

 Cách 3: Cách l y d  li u th  côngấ ữ ệ ủ

T  màn hình Waypoint, vào ừ File, ch n ọ Open, tìm đ ng d n đ n th  m c ch a ườ ẫ ế ư ụ ứ  đĩaổ
GARMIN, vào Garmin, vào GPX, và ch n ọ waypoint,  track,… c n chuy n, kích ch nầ ể ọ
open. 

D i đây là hình các b c chuy n d  li u th  công:ướ ướ ể ữ ệ ủ
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Tìm đ ng d n đ n th  m c ch a  đĩaườ ẫ ế ư ụ ứ ổ  GARMIN:

Vào Garmin, vào ti p ế GPX:
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Ch n ọ waypoint, track,… c n chuy n, kích ch n ầ ể ọ open:

K t qu  thu đ c trên Mapsource:ế ả ượ
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Chú ý: 
Khi dùng Mapsource đ  truy n d  li u, Mapsoure không cho phép chuy n t i t  đ ngể ề ữ ệ ể ả ự ộ
Waypoint vào máy tính đ i v i dòng máy Oregon, 78 seri, 62 seri, eTrex 10-20-30 nhố ớ ư
nh ng dữ òng máy tr cướ . Do đó, cách 1 và 2 ch  chuy n đ c tracks và routes. Đ  kh cỉ ể ượ ể ắ
ph c nh c đi m này nên dùng ụ ượ ể Basecamp đ  truy n d  li u, ho c n u dùng Mapsourceể ề ữ ệ ặ ế
thì dùng cách 3 đ  truy n các đi m Waypoint.ể ề ể

B c 3ướ : Cài đ t các thông s  ph n m m Mapsource:ặ ố ầ ề

- T  màn hình ừ Mapsource, ch n Edit, ch n ọ ọ preferences…
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- Ch n ọ Unit đ  cài đ t đ n v  đo (ch n đ n v  ể ặ ơ ị ọ ơ ị metric).

- Vào Position đ  ch n cách th  hi n t a đ  các đi m theo kinh đ , vĩ đ  (ch nể ọ ể ệ ọ ộ ể ộ ộ ọ
Lat/Lon hddd0 mm.mmm’ ), ho c t a đ  ặ ọ ộ UTM (met), ho c VN2000.ặ

- Vào Waypoint đ  cài đ t bi u t ng (symbol), chi u dài tên đi m,…ể ặ ể ượ ề ể

B c 4: ướ L u d  li u trên máy tính:ư ữ ệ

T  màn hình Mapsource, ch n ừ ọ File, ch n ọ Save as…Xu t hi n màn hình:ấ ệ

- Đ t tên file c n l u và ch n ki u d  li u l u ặ ầ ư ọ ể ữ ệ ư (Save as type):

+ Garmin GPS Database (*.gdb): d  li u ch y đ c trên ph n m m Basecamp.ữ ệ ạ ượ ầ ề
+ MPS files (*.mps): d  li u ch y đ c trên ph n m m Mapsource.ữ ệ ạ ượ ầ ề
+ Text ( Tab delimited (*.txt)) : d  li u ch y đ c trên Notepad, Excel.ữ ệ ạ ượ
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+ DXF (*.dxf) : d  li u ch y đ c trên ph n m m AutoCad ho c Import xu t dữ ệ ạ ượ ầ ề ặ ấ ữ
li u đ c sang ph n m m Mapinfo.ệ ượ ầ ề

Chú ý cách chuy n file sang đuôi file “ *.dxf “:ể

Khi l u d  li u  đ nh d ng *.dxf và mu n l u  h  t a đ  UTM ph i xóa b  t t cư ữ ệ ở ị ạ ố ư ở ệ ọ ộ ả ỏ ấ ả
nh ng Waypoint  có s n trên máy nh  BirdsEye Demo,  Garmin Asia,  Garmin Europe,ữ ẵ ư
Garmin  USA,  Garmin_Asia,  Garmin_Europe,  Garmin_USA,  Grand  Canyon  National
Park… (n u có) tr c thì m i chuy n đ c, n u không xóa s  báo l i.ế ướ ớ ể ượ ế ẽ ỗ
Trên Mapsource  ch n Fileọ  - >Ch n ọ Save as ->Ch n ọ  đĩa c n l u (Save in)ổ ầ ư  -> ch n ọ
tên file (File name) ->Ch n ọ đuôi file * dxf (Save as type) -> OK. Hình các b c l u d  ướ ư ữ
li u sang ệ *.dxf :

          
L u ý: ư V  sinh máy sau m i l n s  d ng và tháo pin ra kh i máy n u không s  d ngệ ỗ ầ ử ụ ỏ ế ử ụ
trong th i gian dài. Trong tr ng h p b  h  h ng liên h  v i nhà cung c p đ c s aờ ườ ợ ị ư ỏ ệ ớ ấ ượ ử
ch a - b o hành chính hãng, không nên t  ý tháo r i.ữ ả ự ờ
Máy đ t tiêu chu n ch ng th m IPX7, có th  ch u đ c trong n c  đ  sâu 1 mét trongạ ẩ ố ấ ể ị ượ ướ ở ộ
vòng 30 phút. Tuy nhiên, trong quá trình s  d ng nên h n ch  ti p xúc v i n c. N uử ụ ạ ế ế ớ ướ ế
ch ng may làm r i xu ng n c nên lau khô tr c khi đem b o qu nẳ ơ ố ướ ướ ả ả

DANH SÁCH KINH TUY N G C CÁC T NH THÀNH C A H  T A Đ  VNẾ Ố Ỉ Ủ Ệ Ọ Ộ
2000

TT T nh, thành phỉ ố Kinh 
tuy n tr cế ụ TT T nh, thành phỉ ố Kinh   

 tuy n tr cế ụ
1 Lai Châu 1030 00’ 33 Long An 1050 45’
2 Đi n Biênệ 1030 00’ 34 Ti n Giangề 1050 45’
3 S n Laơ 1040 00’ 35 B n Treế 1050 45’
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4 Kiên Giang 1040 30’ 36 H i Phòngả 1050 45’
5 Cà Mau 1040 30’ 37 TP. H  Chí Minhồ 1050 45’
6 Lào Cai 1040 45’ 38 Bình D ngươ 1050 45’
7 Y n Báiế 1040 45’ 39 Tuyên Quang 1060 00’
8 Ngh  Anệ 1040 45’ 40 Hòa Bình 1060 00’
9 Phú Thọ 1040 45’ 41 Qu ng Bìnhả 1060  00’

10 An Giang 1040 45’ 42 Qu ng Trả ị 1060 15’
11 Thanh Hóa 1050 00’ 43 Bình Ph cướ 1060 15’
12 Vĩnh Phúc 1050 00’ 44 B c K nắ ạ 1060 30’
13 Hà Tây 1050 00’ 45 Thái Nguyên 1060 30’
14 Đ ng Thápồ 1050 00’ 46 B c Giangắ 1070 00’
15 C n Thầ ơ 1050 00’ 47 Th a Thiên – Huừ ế 1070 00’
16 H u Giangậ 1050 00’ 48 L ng S nạ ơ 1070 15’
17 B c Liêuạ 1050 00’ 49 Kon Tum 1070 30’
18 Hà N iộ 1050 00’ 50 Qu ng Ninhả 1070 45’
19 Ninh Bình 1050 00’ 51 Đ ng Naiồ 1070 45’
20 Hà Nam 1050 00’ 52 Bà R a – Vũng Tàuị 1070 45’
21 Hà Giang 1050 30’ 53 Qu ng Namả 1070 45’
22 H i D ngả ươ 1050 30’ 54 Lâm Đ ngồ 1070 45’
23 Hà Tĩnh 1050 30’ 55 Đà N ngẵ 1070 45’
24 B c Ninhắ 1050 30’ 56 Qu ng Ngãiả 1080 00’
25 H ng Yênư 1050 30’ 57 Ninh Thu nậ 1080 15’
26 Thái Bình 1050 30’ 58 Khánh Hòa 1080 15’
27 Nam Đ nhị 1050 30’ 59 Bình Đ nhị 1080 15’
28 Tây Ninh 1050 30’ 60 Đ c L cắ ắ 1080 30’
29 Vĩnh Long 1050 30’ 61 Đ c Nôngắ 1080 30’
30 Sóc Trăng 1050 30’ 62 Phú Yên 1080 30’
31 Trà Vinh 1050 30’ 63 Gia Lai 1080 30’
32 Cao B ngằ 1050 45’ 64 Bình Thu nậ 1080 30’
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